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Version 5.3.x.x

This software tool is designed to help students master the basic concepts of mathematical
logic, with emphasis on the semantic aspects of it. It is written by Jan Denef from the
KULeuven.
The software is written in the DotNet Framework (version 2.0). At this moment LogicPalet
only works on Windows 7, Windows Vista, Windows XP, and Windows Server 2003 or
higher. It does not need any installation on Windows 7 and Vista: just download the
executable file LogicPalet.exe. Double click on it, and LogicPalet will be running. On
Windows XP it works similarly, but first you have to install the DotNet Runtime Environment
(version 2.0 or higher) in case this is not installed yet. Windows 7 or Vista always ships with
the DotNet Runtime 3.0, or higher, preinstalled. For Windows XP, you can download the
DotNet Runtime Environment here. In the future we plan to port LogicPalet to Linux, Mac,
and Solaris, using the Mono Project.
Short Overview. The software enables you to write logical formulas very fast by clicking on
buttons, and to find any syntax errors. LogicPalet can verify whether or not a logical formula
is true in a given GeoWorld: this is a structure consisting of figures on a chessboard. Such a
GeoWorld can be easily constructed and graphically presented by LogicPalet. It can also
explain why a formula is true (or false) in a given GeoWorld. Using the software IDP as a
plug-in, LogicPalet can generate a GeoWorld satisfying given conditions. Moreover,
LogicPalet can determine whether or not a logical formula is true in a given DecaWorld, and
explain why. A DecaWorld is a structure with less than ten elements and any number of unary
and binary relations, and constants. It also enables you to enter the description of a
DecaWorld into your computer very fast. Using the software SPASS as a plug-in, LogicPalet
can verify whether two formulas are logically equivalent, or whether a formula is a logical
consequence of given formulas. This is the component AskSpass. Another component of
LogicPalet is the proof assistant LPproofAssistant which enables students to build correct
formal proofs using very simple deduction rules. Moreover LogicPalet supports online
HomeWork: the students have to solve exercises posted on the internet by the instructor. The
grading of the homework is done online and the results are sent to a database. LogicPalet also
contains a HomeWork Editor to enable instructors compile exercises and post them on the
internet. Having all these components integrated in one, makes LogicPalet a versatile
didactical tool.
A very important kind of exercises is to translate statements in natural language to logical
formulas. If a translation is faithful1 (in the sense that its correctness does not depend on the
special meaning of the used relations) then it is logically equivalent to any other faithful
translation. The student can use AskSpass to verify whether his translation is correct (and
faithful) by comparing it with the translation of the instructor (this is done automatically for
online HomeWork). For statements about GeoWorlds the LogicPalet automatically tries to

1

We recommend instructors to avoid translation exercises involving equivalence relations, because the notion of
faithful translation is not very natural in that case. Alternatively you can only require that the translation is
faithful with respect to a specified set of constraints (e.g. the constraint that a given relation is an equivalence
relation). The HomeWork component of LogicPalet can verify whether the student’s translation is faithful with
respect to specified constraints.

LogicPalet Version 5.3.x.x

2/7

generate a counterexample if the translation is wrong. Extensive experiments at KULeuven
show that the plug-ins SPASS and IDP are almost always powerful enough for these tasks.
The logical formulas have to be written in Unicode syntax.
Unicode syntax:
∧
∨

and
or

→ implication
↔ equivalence

¬
≠

∀
∃

negation
not equal

for all
there exists

Unicode syntax for quantifiers:
(∀x)Triangle(x)

(∃x)Triangle(x)

Don’t forget the brackets! Blanks are irrelevant, except that they are not permitted inside
variables, constants, relation and function identifiers.
Variables, constants, relation identifiers and function identifiers are strings consisting of
letters or digits, starting with a letter and not containing any blanks. Such strings are called
identifiers. You can use three kinds of brackets: ( ) { } [ ], except that for quantifiers you can
only use the brackets ( ).
Operator binding:
(strongest binding)

∀ ∃ ¬ ∧

∨

→

↔

(lowest binding)

For identical connectives, the binding increases from left to right.

P ∧ Q ∧ R is P ∧ (Q ∧ R)
P ∧ Q ∨ R is (P ∧ Q) ∨ R

P ∧ Q → R is (P ∧ Q) → R
P → Q ↔ R is (P → Q) ↔ R

P → Q → R is P → (Q → R)

¬P ∨ Q is (¬P) ∨ Q

Smart Write and Jump. For example, if you click on the button “LeftOf” then LeftOf(*,*) is
written in the focussed text field. Next, when you click on the button “x” then the first * is
replaced by x and the caret moves automatically to the next *, and so on. In this way you
never have to type the commas and the brackets. There are two sets of such buttons in
window FormulaWriter: Button Set1 and Button Set2, and you can switch between them by
clicking on the toolbar button “Switch buttons”. Moreover you can edit these buttons (i.e.
changing the text that they write) by right clicking on such a button. Afterwards you can
return to the defaults by the menu item “View > Buttons”. Smart Write and Jump is also
implemented for the quantifiers, just try it!
Syntax verification. You can verify whether a formula contains no errors with respect to the
Unicode syntax, by selecting one or more formulas (separated by ;) in window FormulaWriter
and clicking on “Check Syntax” in the drop-down menu “Tools”. This does not verify
whether the names of variables, constants, relations and functions are different, or whether
they have the correct number of arguments. But this can be verified by clicking on “Get
Declarations” in the drop-down menu “Tools” (if there are no free variables).
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Tip
Many labels, buttons and menu items have tool tips: if you point to them with the mouse, then
some text will pop-up giving explanation.
Importing and exporting formulas. You can copy-paste formulas and text from a pdf
document (which is prepared2 for it) towards the LogicPalet, using Adobe’s pdf reader
(version 8 or higher). Most other pdf readers are not suitable for this. At the other hand, copypaste of formulas from a pdf document towards text editors will often fail to render the ≠
symbol correctly, unless the pdf is obtained by converting an MS-Word, MS-PowerPoint or
rtf document. You can also copy-paste from (suitable) html pages, towards the LogicPalet.
Moreover, you can copy-paste between text editors (such as WordPad and MS-Word) and the
LogicPalet. This also works with MS-PowerPoint. If your text contains formulas and you
copy-paste from LogicPalet towards Notepad then you have to choose for a Unicode font in
Notepad, but for WordPad and MS Word this is not necessary. As Unicode font we
recommend "Lucida Sans Unicode" (at 9 points), which is the default font in LogicPalet.
Pasting into LogicPalet keeps the format (font and color) of the target, unless you use Edit >
Paste special. You can drag-drop from LogicPalet to most text editors keeping the format of
the source, but drag-drop towards LogicPalet is (in most cases) only possible if you drag from
the same window (this is to avoid problems with Unicode fonts). Some email clients do not
support Unicode symbols. For this reason it is sometimes preferable to use ASCII-code syntax
instead of Unicode syntax. You can translate to/from ASCII-code syntax by the drop-down
menu “Translators” in window FormulaWriter.
The main text area in window FormulaWriter can be saved to a file with extension .rtf, and
any such file can be imported (use the drop-down menu “File” of window FormulaWriter).
AskSpass. By clicking on “A ↔ B ???” in the drop-down menu “Ask Spass”, you can ask
whether the formulas A and B are logically equivalent. This only works when there are no
free variables, such formulas are called sentences. Your formulas have to be in the text fields
A and B of window FormulaWriter. Similarly, by clicking on the button “A → B ??? ” you can
ask whether B is a logical consequence of A. Here A can be one or more sentences (separated
by ;). Be careful to stop Spass when it is running to long and consuming to many resources.
Indeed, Spass may never find an answer to your question… The first time that AskSpass is
used, LogicPalet asks permission to install the plug-in SPASS.exe. This only takes a fraction
of a second, and you don’t have to be connected to the internet. The plug-in SPASS was
developed by the Max Planck Institut Informatik. When you click on the button A, the content
of the text field A is deleted and replaced by the content of the clipboard. The same holds for
button B. Instead you can also drag-drop from any source into button A or B. The result takes
the default format.
GeoWorld. You can make a GeoWorld by clicking on the menu item “Make a GeoWorld” in
the drop-down menu “Worlds”. This opens a new window: the GeoWorld window. A
GeoWorld consists of figures on a chessboard. The figures can be triangles, squares or
pentagons. The logical formulas that can be interpreted in such worlds can contain the
following relation identifiers. Unary relations: Triangle, Square, Pentagon, Small, Medium,
Large. Binary relations: Smaller, Larger, LeftOf, RightOf, FrontOf, BackOf. The
2

Converting an MS-Word, MS-PowerPoint, or rtf document to pdf does not require any precautions. But
converting from TeX or LaTeX needs special care: one should not convert directly to pdf, but first to dvi, from
there to postscript, and finally to pdf. Not all convertors are suitable. For converting postscript to pdf we
recommend using Adobe Acrobat Distiller (version 8 or higher), other convertors may render ≠ incorrectly after
copy-paste to LogicPalet.
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interpretations of these relation symbols are the obvious ones: Larger and Smaller have to be
interpreted as strictly larger and strictly smaller. LeftOf (x,y) is interpreted as “the column of
x is on the left of the column of y”, FrontOf(x,y) is interpreted as “the row of x is in front of
the row of y”, and so on. Each figure can have at most one name. LogicPalet can determine
whether or not a logical formula (of the above kind) without free variables is true in a given
GeoWorld. For this you have to select that formula in window FormulaWriter, and click on
the menu item “Worlds > Evaluate in GeoWorld”. You can evaluate more than one formula at
the same time: for this you have to select all these formulas separated by ; and click on
“Evaluate in GeoWorld. You can import/export a GeoWorld from/to a file or from/to the
clipboard, using the drop-down menu “File” in window GeoWorld.
LogicPalet can also explain why a logical formula (of the above kind) is true (or false) in a
given GeoWorld. For this you have to select that formula in window FormulaWriter, and click
on the menu item “Worlds > Why True/False > In GeoWorld”. This opens a new window
“WhyTrueFalse” providing full explanation, by clicking on the links Why? for all the
components of the formula. Use the drop-down menu “Window” to navigate more easily
through the explanation pages. It is necessary that all figures in the GeoWorld are given a
name. This can be done by clicking on the menu item “Tools > Name All” in the window
GeoWorld, or by editing each figure separately. Note that it is impossible to edit the
GeoWorld while the window WhyTrueFalse for GeoWorld is open.
Clicking on the menu item “Worlds > Generate a GeoWorld”, the software tries to generate a
GeoWord satisfying given conditions. See the tooltips for more information. The first time
you use this functionality, LogicPalet asks permission to install the IDP plug-in, consisting of
GidL.exe and LidL.exe. This only takes a fraction of a second, and you don’t have to be
connected to the internet. The IDP software was developed by the group Knowledge
Representation and Reasoning (KRR) at the KULeuven.
GeoWorld is inspired by, but different from, commercial software called Tarski's World
published by CSLI at Stanford University. The component GeoWorld of LogicPalet is not the
product of CSLI.
An important kind of exercises is to determine whether or not a given logical formula is true
in a given GeoWorld or DecaWorld. After finding the answer, without using LogicPalet, the
student uses the software to see whether his answer is correct. If his answer is not correct,
then the student can find his error using the tool “Why True/False” as explained above.
DecaWorld. You can make a DecaWorld by clicking on the menu item “Make a DecaWorld”
in the drop-down menu “Worlds” of window FormulaWriter. This opens a new window: the
DecaWorld window. A DecaWorld is a structure with less than ten elements and any number
of unary and binary relations, and constants. You can choose the names of these relations as
you wish (any identifier is allowed). The elements of the universe have to be the digits 1, 2, 3,
…, N, with N < 10. Functions are not allowed, but you can work with as many constants as
you want. In the description of the relations and constants, blanks are irrelevant. For the
description of the unary relations: write the elements without commas between them. For the
description of the binary relations: write the tuples (without commas between them) in
condensed form (aA,bB) = (a,b)(a,B)(A,b)(A,B). For example (12,345)(5,1) is the condensed
representation of the following set of tuples: (1,3)(1,4)(1,5)(2,3)(2,4)(2,5)(5,1). In this way
relations can be represented in a very practical way! You don’t have to memorize these
conventions: if you point with the mouse to the column headers in the DecaWorld window,
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then the tooltips will popup. You can import/export a DecaWorld from/to a file or from/to the
clipboard, using the drop-down menu “File” in window DecaWorld.
LogicPalet can determine whether or not a logical formula without free variables is true in a
given DecaWorld. For this you have to select that formula in window FormulaWriter and
click on the menu item “Evaluate in DecaWorld” in the drop-down menu “Worlds”. You can
evaluate more than one formula at the same time: for this you have to select all these formulas
separated by ; and click on “Evaluate in DecaWorld”.
LogicPalet can also explain why a logical formula (without free variables) is true (or false) in
a given DecaWorld. For this you have to select that formula in window FormulaWriter, and
click on the menu item “Worlds > Why True/False > In DecaWorld”. This opens a new
window “WhyTrueFalse” providing full explanation, by clicking on the links Why? for all the
components of the formula. Use the drop-down menu “Window” to navigate more easily
through the explanation pages. It is necessary that all elements in the universe of the
DecaWorld are given a name. This can be done by clicking on the menu item “Tools > Name
All” in the window DecaWorld. Note that it is impossible to edit the DecaWorld while the
window WhyTrueFalse for DecaWorld is open.
Online Homework. For online homework, click on the menu item “Online HomeWork” in
window FormulaWriter. A new window “HomeWork Handler” will open. Click there on the
button “Help” and follow the instructions. Remember that you have to be connected to the
internet. The instructor can choose between several policies. One policy is that only the
grades of correctly solved exercises are sent to the server and that the student can keep trying.
Another policy is that the student has only one try for each exercise. Each homework
assignment can have a different policy. The date and time of when an exercise is solved by
the student, are not sent to the database, to protect privacy. By clicking on the button “Show
my grades” the student can see his grades.

An important kind of exercises is to determine whether a given formula B is a logical
consequence of some given formulas A1, A2,… If it is a logical consequence, then the student
has to give a formal proof. This can be done by the LPproofAssistant. If it is not a logical
consequence then the student has to give a counter example, that is a structure in which A1,
A2,… are true and B false. Often one can take a DecaWorld for such a structure, and then the
student can verify with the software whether his DecaWorld is indeed a counterexample.
LPproofAssistant. The student can construct formal proofs using the LPproofAssistant. Click
on the menu item “Proofs > ProofAssistant” in window FormulaWriter to open the window
LPproofAssistant. With this tool one constructs correct formal proofs using the KE deduction
rules, which are much simpler than the deduction rules used in most other existing proof
assistants. Such proofs are called KE proofs. The tool is inspired by, but different from, the
software WinKE developed by Ulle Endriss.

To construct a KE proof that a given sentence B is a logical consequence of a given set T of
sentences, one has to derive a contradiction from T and the negation of B, using the KE rules
of deduction. It is allowed to make case distinctions. For any sentence C one can split up the
proof (at any stage of its construction) in two cases: the case that C is true and the case that C is false.
This yields two branches. Usually one takes for C a sentence that appears already in the proof
or a sub-sentence of such a sentence. Using the tool, one first selects such a sentence before
clicking on the button “Case Distinction”. Repeated case distinctions yield a proof tree which
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might have many branches. A KE proof is complete if each branch contains a contradiction,
meaning that the branch contains both a sentence and its negation. Such a branch is called a
closed branch.
A KE deduction is always based on sentences that appear in the same branch and results in
appending the conclusions to that same branch. In the LPproofAssistant that branch has to be
activated first (unless there are no case distinctions), by selecting the corresponding case and
clicking on the button “Activate Branch”. To apply a deduction rule, first select the sentences
on which to apply the rule and click on the button for that rule. The results of the deduction
are then automatically appended to the activated branch. After you obtained both a sentence
and its negation in the activated branch, you have to select these two sentences and click on
the button “Contradiction” to formally close that branch. Your KE proof is complete when all
branches have been closed in this way. In the LPproofAssistant window you can choose
between two views, using the tabs: either you can view the whole proof tree, or else you can
view only the activated branch. You can also hide some of the sentences to have a better
survey and later unhide them if necessary.
Next we give a complete list of the KE rules of deduction.

The KE Deduction Rules
The ∃ Rule. From (∃x)A(x) one deduces A(c), where c is a new constant that does not yet
appear in the current branch, and A(c) is obtained from A(x) by replacing each free

occurrence of the variable x by c. Moreover, from ¬(∀x)A(x) one deduces ¬A(c), with c and
A(c) as above.
The ∀ Rule. From (∀x)A(x) one deduces A(t), where t is any term without variables, and
A(t) is obtained from A(x) by replacing each free occurrence of the variable x by t. Moreover,

from ¬(∃x)A(x) one deduces ¬A(t), with t and A(t) as above.
The Propositional Rule. The following table shows the deductions that are allowed by the
Propositional Rule, where ¬A denotes the complement of A. The complement of a sentence A
is C when A is of the form ¬C, and else the complement of A is ¬A.
Assumption 1

Assumption 2

A∧B

Conclusion 1

Conclusion 2

A

B

A∨B

¬A

B

A∨B

¬B

A

A→B

A

B

A→B

¬B

¬A

A↔B

A

B

A↔B

B

A

A↔B

¬A

¬B

A↔B

¬B

¬A

¬¬A

A

¬(A ∧ B)

A

¬B

¬(A ∧ B)

B

¬A

¬(A ∨ B)

¬A

¬B
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¬(A → B)

A

¬(A ↔ B)

A

¬B

¬(A ↔ B)

B

¬A

¬(A ↔ B)

¬A

B

¬(A ↔ B)

¬B

A

¬B

The Equality Rule. When the given sentences contain equalities or inequalities one also
needs the Equality Rule, but this rule is not yet implemented in LPproofAssistant. The rule
asserts that t = t and deduces from t = u that A(t) = A(u) for any terms t and u without
variables. Here A(t) is obtained by replacing all free occurrences of the variable x by t in a
formula A(x), and similarly for A(u). Moreover t ≠ u is considered identical to ¬ t = u.

